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1 Introduction

This documentation is designed to guide you through the ACA 1095 Reporting program, also referred to
as ACA 1095, and make learning the program as easy as possible. Directions for making full use of the
program are included in this Help documentation.

Under the regulations regarding the Affordable Care Act, all companies that provide self-insured health
insurance to their employees and all businesses with over 50 employees are required to complete the
1095-C or 1095-B filing requirements. The returns and transmittal forms must either be printed and
mailed to the IRS by the last day of February or e-filed to the IRS by the last day of March starting in
2016. In addition, the employee copy of the form must be mailed or emailed to the employee on or before
January 31. The transmittal (1094-C or 1094-B, respectively) can be printed and filed with the 1095-C or
1095-B for the IRS. The transmittal forms contain company and other information as required by the IRS.
This information is automatically printed based on the applicable client information entered.

Forms for each employee contain information regarding the employee, the provided coverage, and any
dependents covered under the employees policy. Submitting these forms in 2015 (for information
regarding the 2014 tax year for covered individuals was optional for 2015, but is mandatory beginning on
the applicable dates in 2016. The forms are submitted every year following the rules regarding the dates
above. Companies with 250 or more employers must file the forms electronically with the IRS. Electronic
filing is optional for those companies with less than 250 employees.

The final regulations for the 1094-B and 1095-B can be found under Section 6055. The final regulations for
the 1094-C and 1095-C can be found under Section 6056.

1.1 Overview

ACA 1095 Reporting is designed to maintain an employee database to be used in printing the IRS Forms
1094-C, 1095-C, 1094-B, and 1095-B for each insured employee and dependents covered by the
employer. Employee data can be entered manually or imported via a spreadsheet. Insurance, safe-harbor
and SHOP Identifier codes can be input for any applicable month during the year for each employee.
Employee share of lowest cost of monthly premiums can be input. Dependent information can be entered
or imported, including all months covered for each dependent.

IRS Forms 1095-B and 1095-C as well as transmittal forms can be printed to be mailed to the IRS or e-
filed by the applicable due dates. Required employee form can also be printed and distributed to each
employee or emailed if desired.

1.2 Home Screen

The Home Screen for ACA 1095 Reporting displays the company name and file including the location of
the file on your hard drive or network drive. The date the data file was last modified is also displayed as
well as the latest update to the program.

In addition there are several toolbar icons for some of the most commonly used functions int he program.
These options are also available via the drop-down menu at the top of the screen. The drop-down menu
contains all features in ACA 1095 Reporting and can always be accessed from the Home Screen.

The company information is displayed including the file location, last modified date and version date of
the program. The file statistics are also displayed for your company showing the total employees and
dependents, terminated employees, and new hires.
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1.2.1 Toolbar

The icons representing the toolbar options are among the most commonly used features in the ACA
1095 Reporting. These options can also be accessed via the main menu. The following toolbar icon
options are:

Client Info - Access and change any of the company preferences.

Employees - Add or edit any employee or dependent data.

Defaults - Change any defaults for new employees entered or imported.

Reports - Access and print all reports including IRS Tax Forms.

Backup - Make a backup of your data file.

Restore - Restore a previously made backup.

Reset - Reset the company file for the next year.

Update - Check for and apply the latest update for ACA 1095 Reporting.

Help - Access the system help, provide feedback, or view other helpful resources.

Exit - Close the program.

1.2.1.1 Client Info

Add or edit any client information here. See Client Information for a detailed explanation of the information
entered for the company. 

1.2.1.2 Employees

This button displays the Employee screen where you can add new employees, edit existing employees
or add dependents.

To add a new employee, click the "Add" button or the "+" button in the lower left corner of the screen.

To edit an existing employee, add dependents to an existing employee or modify dependent coverage
information, highlight the employee in the grid and then click the "Edit" button.

Modifying Offer & Coverage Codes and Amounts
There are two ways to accomplish adding new codes for an employee or changing existing codes.

Method One - While in the Edit mode, click the Start Month and End Month, choose the applicable
Offer Code from the drop-down list, the Share Cost amount, and the applicable 4980H Code form the
drop-down list. Then click the "+" button to add another date range. Choose the second range, applicable
codes and amounts and click "Save" to save the changes for the employee.

Method Two - (Form View) - Click the gear icon and choose the option to "Edit in Form View". This
option displays the Form View screen which displays all of the months and let you choose the individual
months to apply the Offer & Coverage Codes and amounts. In addition, there are arrows below each
month's information for the employee which allow you to apply the same Offer & Coverage codes and
amounts either forward or backward. This can be useful if codes for an employee changed in the middle
of the year. Select the code for the month that the code changed and then click the arrow pointing to the
right to change all of the months codes until the end of the year. You can also choose a code for any
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month and click the left arrow. Click the arrow in the middle pointing both left and right to make the
changes for the entire year.

Adding or modifying covered individual (dependent) data
The first item in the Individuals list is always the employee. To change the employee months of coverage
information, click the gear and then click "Edit". Choose the months that the individual was covered
during the year or "All 12 Months" if the employee was covered the entire year. Click "Save" to save any
changes for the employee.

To add new dependents, click the "Edit" button and then click the "+" at the bottom of the "Individuals"
grid. This will display the dependent screen where you can enter the name, SSN (or date of birth is SSN
is not known) and the months that the individual was covered for the year. Click "Save" to save the
dependent information.

1.2.1.3 Defaults

This option allows you to create default settings that you can apply to multiple employees at once. You
can create a default setting to apply by first clicking the "Defaults" icon in the toolbar and then clicking
the "+" button in the lower left to add a new default to apply. Note, you can also highlight one or more
employees from the Employee screen (also accessed from the toolbar) and clicking the "+" button to
add a default. Once you create and add the defaults to apply, they can be saved with a unique name and
applied to other employees or groups that are selected from the Employee Add/Edit screen.

This option can be especially useful if you have imported employee data and need to add codes for offer
and coverage. For instance, you can select multiple employees to assign an offer and coverage code of
2A with an employee share of the lowest cost monthly premium of $100 and Applicable Section 4980H
Safe Harbor code of 2C. Add that default by clicking the Defaults icon on the toolbar and then click the
"+" button to add that default. Select the appropriate codes and amounts and click "Save" to save those
defaults.

Then select the employee or multiple employees, click "Edit" and then click "Load from Defaults...".
Select the applicable items by placing a check in the box next to the defaults to apply. In this case,
check the box next to "Offer & Coverage" and then click "Save" to save the changes.

1.2.1.4 Reports

This option will display all available reports for ACA 1095 Reporting. 

Choose any of the following to print:

Employee Reports - Choose the default sort order and other options by clicking the "Configure

Settings" button.

IRS Tax Form 1095-C - Choose the printing options for the IRS Form including whether to print

the transmittal report for filing with the IRS.

IRS Tax Form 1095-B - Choose the printing options for the IRS Form including whether to print

the transmittal report for filing with the IRS.

Click the Configure Settings to change default or saved settings for each report.  Each report can be

printed, previewed on-screen, or printed to file in .pdf format.
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1.2.1.5 Backup

This option will make a backup of the data file. By default the backup file is saved to the "BACKUPS"
folder located in your data file location however, it can be saved in any location desired. Use the folder
icon to navigate to a different location if you want the backup save to another drive and folder.

1.2.1.6 Restore

This option will restore a previously made backup of the data file. To restore a previously saved backup,
select the desired backup listed in the grid and then click the "restore" button. Note, restoring a
previously made backup will overwrite your existing data file.

1.2.1.7 Reset

This option will prepare your employee and dependent data file for the new year. In addition, it will remove
all employees that have been terminated during the current year and place them in a terminated
employee file. A prior year file will also be created which will allow you to print reports or view data
contained in the prior year file.

Before you can reset your data file to a new year, you must check the box acknowledging the following:

Verify all employees who have worked at least one month in the current year have been entered.

Verify all of the coverage codes for each employee have been entered.

Verify all reports have been printed that are required for the current year.

Once you have checked each box, you will be able to click the Reset button.

1.2.1.8 Update

This option will check to see if there are later updates to the program via the Pro-Ware website. If found,
the program will prompt to update now or at a later time.

1.2.1.9 Help

This option displays the Help system in your default web browser. Navigate to topics using the table of
contents, index, or searching by keyword.

1.2.1.10 Quit

Enter topic text here.
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2 File Menu

The following options are available from the File menu:

Client Information - Selecting this option will display all configuration options for the company. 

Backup - This option will make a backup of the data file.

Restore - This option will restore a previously made backup of the data file.

Import Data - This option allows you to import employee and dependent data,

Close Window - This option closes the program.

Exit - This option closes the program.

2.1 Client Information

The Client Information contains all configuration options for your company. There are five different
sections for company information, each containing specific default options and value for your company.
This information can normally be entered or changed at any time. At the bottom of each screen is a
direct reference for the IRS Form and part that the information is reported. Certain screens may be
enabled or disabled based on the form that your firm is required to submit to the IRS (Form 1095-C or
1095-B).

 Each of the sections of the Client Information are described below in detail:

General Section
This section contains the company (employer) name, the applicable reporting year for the company, the
Employer Identification Number (EIN), the address, contact information, and any notes you may want to
enter for your company.

Report / Default Option Section
Use this section to choose the applicable form that the employer is required to file (IRS Form 1095-C or
1095-B). In addition, default codes can be set for either form. The coding and share of cost fields are
automatically enabled/disabled based on the form that the employer is required to file.

Designated Government Entity Section
If the employer is a Designated Governmental Entity (DGE), enter the information in this section.

Issuer or other Coverage Provider Section
Use this section to enter issuer or other coverage provider information, if required.

2.2 Backup

This option will make a backup of the data file. By default the backup file is saved to the "BACKUPS"
folder located in your data file location however, it can be saved in any location desired. Use the folder
icon to navigate to a different location if you want the backup save to another drive and folder.

2.3 Restore

This option will restore a previously made backup of the data file. To restore a previously saved backup,
select the desired backup listed in the grid and then click the "restore" button. Note, restoring a
previously made backup will overwrite your existing data file.
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2.4 Import Data

This option allows you to import employee and dependent data, either from the spreadsheet designed
specifically by Pro-Ware for ACA 1095 Reporting or from a free spreadsheet that has employee and/or
dependent data.

To import the data from 1095-C or 1095-B spreadsheet provided by pro-Ware, choose that option as the
type pf source file to be used. When importing the Excel data from the Pro-Ware provided spreadsheet,
the default dependent maximum is 10 dependents, but that can be changed to a greater number of
dependents should your employees have more dependents. You can elect to delete all employee data
currently in the file or the employee data that was imported during the last import. Note that if you delete
all employee data, all dependent data is also deleted.

To import data from a spreadsheet with employee information, select that option from the list. To define
the field mapping of the fields in the spreadsheet, click the Field Mapping button. Here you can change
the mapped definitions to appropriately match the columns in the employee import spreadsheet. In
addition, you can set default value for for any codes and default share of cost amounts for all imported
employees. The number of heading rows to skip can also be entered if you have header rows that need
to be skipped in the employee import file. You can elect to delete all employee data currently in the file
or the employee data that was imported during the last import. Note that if you delete all employee data,
all dependent data is also deleted.

To import data from a spreadsheet with dependent information, select that option from the list. To define
the field mapping of the fields in the spreadsheet, click the Field Mapping button. Here you can change
the mapped definitions to appropriately match the columns in the dependent import spreadsheet. The
number of heading rows to skip can also be entered if you have header rows that need to be skipped in
the dependent import file. You can elect to delete all dependent data currently in the file or the dependent
data that was imported during the last import.

Click the "Import" button once you have made the selections and then navigate to the location of the
import file and select it. 

2.5 Close Window

This option closes the program.

2.6 Exit

This option is the same as the Close Window option and closes the program.
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3 Edit Menu

The Edit menu consists of the following options:

Undo - Reverts the last change made.

Cut - Removes and places the highlighted item into the clipboard.

Copy - Copies and places the highlighted item into the clipboard.

Paste - Places the contents of the clipboard into the selected area.

Delete - Removes the highlighted item without saving it to the clipboard.

Select All - Selects multiple items at once.

Preferences - Allows you to change program preferences such as updating and data folder

preferences.

3.1 Editing Options

The Edit menu consists of general editing features including Undo, Cut, Copy, Paste, Delete, and Select
All. These options are generally used and are only active when you are in the employee and dependent
add and edit screens. Undo will revert the last change that you made. Cut and Copy will place the
highlighted item into your clipboard. Paste will place the data in the clipboard into the selected area in
the field on the data entry screen. The Delete option deletes any highlighted data and it is not available in
the clipboard. Select All will select multiple items or fields at once.

3.2 Preferences

This option allows you to make any program preference changes. You may select any section and
change any preference item and the change will automatically be saved when clicking the "Done" button.
Note that some changes may not take affect until you restart the program.

General Section
The following items can be changed in the General Section of ACA 1095 Reporting:

Require password when starting program - Check this box to password-protect the program.

Ask for confirmation before exiting - This option will display an exit confirmation dialog box

when closing the program.

Show splash screen when starting - This option bypasses the splash screen to the program when

unchecked.

Skip the home screen when starting - This option will take you directly to the employee data entry

screen when you start the program.

Open windows stacked - If this box is unchecked, windows positions and sizing are remembered.

Restore messages - This button will display all boxes that have been suppressed.

Favorite Reports - This button allows you to manage your favorite reports.

Data Folder Section
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The default data folder can be changed int his section. To change the default data location, click the
ellipsis (...) button located to the right of the Default Data Folder path. If you change your default data
folder, you will be asked to create the following sub-folders if they don't already exist:

Backups - Backups that are made will be stored in this location.

Reports - Reports printed to disk are stored in this folder.

SampleData - The sample data file included with the application.

Email Section
You can send emails in the program using either your default mail program or using ACA 1095
reporting's built-in email client. If you use the built-in mail client, you will need to enter the applicable
SMTP Address information. If you do not know these settings, you may have to contact your network
administrator.

Software Updates Section
In this section you can select the frequency with which to check for updates. The default is seven days,
but you can select every 30 days, each time the program is started or to never check for updates. Other
parameters of updating can be changed by clicking the "Advanced Options" button. The Advanced
Options allows you to change how the program is updated, whether to use an alternate server, proxy
server settings, and user account options. These settings are normally only changed if you are having
problems downloading or installing the updates and require assistance from a network administrator.

Employee List Section
This section allows you to select the items displayed or change the order in which items are shown in
the employee list. Simply check the box for an item to display it or remove the check to hide the item.
To reorder the items, highlight the item you want to move up or down and click the up or down arrow to
move the item up or down. Click the first or last button to move the item to the first (or last) in the list.
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4 Reports Menu

This option will display a listing of all of the reports available in ACA 1095 reporting.

Choose any of the following to print:

Employee Reports - Choose the default sort order and other options by clicking the "Configure

Settings" button.

IRS Tax Form 1095-C - Choose the printing options for the IRS Form including whether to print

the transmittal report for filing with the IRS.

IRS Tax Form 1095-B - Choose the printing options for the IRS Form including whether to print

the transmittal report for filing with the IRS.

Click the Configure Settings to change default or saved settings for each report. Each report can be

printed, previewed on-screen, or printed to file in .pdf format.
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5 Housekeeping

Selecting this option will allow you to do the following:

Reset for New Year - This option prepares the data file to enter new employee and dependent

information for the next year.

Rebuild Index Files - This option will rebuild the database index for each database file.

5.1 Reset for New Year

This option will prepare your employee and dependent data file for the new year. In addition, it will remove
all employees that have been terminated during the current year and place them in a terminated
employee file. A prior year file will also be created which will allow you to print reports or view data
contained in the prior year file.

Before you can reset your data file to a new year, you must check the box acknowledging the following:

Verify all employees who have worked at least one month in the current year have been entered.

Verify all of the coverage codes for each employee have been entered.

Verify all reports have been printed that are required for the current year.

Once you have checked each box, you will be able to click the Reset button.

5.2 Rebuild Indexes

Choose this option to have the program rebuild the index files for each database. Rebuilding index files
may become necessary due to an import or other reason. You should normally only run this option if
directed by Pro-Ware's technical support staff.
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6 Help

The following options are available in the Help menu:

About ACA 1095 Reporting - This option displays information about the program and other

specifications about your system.

Help - This displays the Help system in your default web browser. Navigate to topics using the

table of contents, index, or searching by keyword.

Learning Resources - This option displays the various resources for the program including FAQ's,

How To documents and other helpful information.

Feedback - This displays the Feedback screen where you can ask a question, provide comments

or attach a data file for analysis by the support staff.

Activate - This option will allow you to enter new subscription codes to activate the program.

Check for Updates - This option will check to see if there are later updates to the program via the

Pro-Ware website.

6.1 Learning Resources

This option displays the various resources for the program including FAQ's, How To documents and other

helpful information.


